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Introduction 

 

Introduction 

 

This section provides valuable information about teaching TechnoMe. It 

includes a description of the Teacher Guide, as well as an overview of the 

course. In addition, there are ideas for implementation and technology 

integration.  

 

For additional guidance, open the course in TechnoHub and select Get 

Started to access preparatory steps, resource list, and scheduling timetable. 
 

How to Use this Guide 

TechnoMe Overview 

Technology Integration Ideas 

 



  Getting Started 

Copyright © TechnoKids Inc. iii TechnoMe | Microsoft 365 

TechnoMe Overview 

 

Each person is special! 

 

In this course, students celebrate their own unique characteristics. They 

use a PowerPoint template to create an All About Me slide show. The 

mini biography outlines personal details, accomplishments, goals, and 

interests. Upon completion, students share their slide show with a friend 

to compare how they are similar and different. This is an excellent way 

to enhance self-esteem, foster relationships, and develop fundamental 

technology skills. 

 

➢ In Session 1, students will begin creating their "All About Me" slide 

show. The first task is to design a title slide using a Microsoft PowerPoint template. 

They will enter their name in a text box and customize the font by adjusting the 

size, style, and color. Next, students will complete a slide template that includes 

descriptive sentences, providing details such as their name, age, city, and 

favorite activity. As an optional step, students can fill out the "Fun Facts" template, 

sharing additional information like their favorite subject, what annoys them, and 

the things they enjoy reading or watching. 

➢ In Session 2, students complete a third slide in their All About Me slide show, which 

centers on a career goal. They do this by finishing the sentence, "When I grow up, 

I want to be a…". They insert an image representing what they aspire to be in the 

future. Next, they create a text box and type in the desired job title. Upon 

completion, students discuss their work with peers. 

➢ In Session 3, students will create the fourth slide in their "All About Me" slide show, 

showcasing things they enjoy. To kick off the activity, they will take a digital photo 

of themselves. Using a slide template with a flower shape, each petal will be filled 

with a clipart representing their favorite things. In the center, students will insert a 

cropped version of their photo. This slide can be printed for display on a class 

bulletin board. For an extra fun activity, students can place their photo into a 

puzzle template, cut out the pieces, and reassemble the image. 

➢ In Session 4, students create a slide about their family. They create a graph that 

shows the number of adults, children, and pets in their home. Using shapes, they 

use different images for each type of family member. An optional activity is 

available that has students construct their family tree using a cloud shape to add 

each person's name to a branch. 

➢ In Session 5, students add transitions to the All About Me slide show. They choose 

their preferred transition effect and then apply it to all slides. Then, they run the 

slide show to practice advancing to each slide. Afterwards, they use a checklist 

to verify that it is ready for viewers. Optional instructions are provided on how to 

incorporate any slides from previous skill reviews or extension activities into the 

current slide show. For instance, students may wish to include their learning goal, 

fun facts, family tree, or puzzle if they did those additional activities. 

➢ In Session 6, students share their All About Me slide show with an audience. 

Following the presentation, they participate in a discussion to explore the 

similarities and differences among their classmates. They identify peers who share 

the same age, interests, or goals. This activity underscores both the commonalities 

within the group and the unique qualities of everyone. 
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Technology Integration Ideas 

The TechnoMe course integrates technology into an All About Me social studies unit. The activities 

are an ideal way for children to develop self-awareness, accept differences in others, and build 

relationships. The activities are completed using a template, which supports beginners with limited 

keyboarding and computing skills. This course can be modified for older students by customizing 

the template to add additional slides using provided resources. 

 

Benefits to incorporating an All About Me unit into curriculum: 

• Build Self-Esteem: Use the All About Me activities to have students reflect upon what 

makes them special. By recognizing characteristics that make them unique, students 

develop a sense of self-worth. 

• Learn about Students: Use the All About Me activities to get to know your students. 

Discover their strengths, goals, likes, and personal interests. This is a fun way for students to 

tell you about themselves. Use this information to support learning. 

• Develop Friendships: Use the All About Me activities to help students recognize others in 

the class that have similar interests. This can become a starting point for fostering 

relationships amongst students. 

• Build a Sense of Community: Use the All About Me activities to have students learn about 

one another. By sharing personal details students form a connection with one another.  

• Develop Oral Communication Skills: Use the All About Me activities to have students 

practice public speaking and active listening. 

 

Suggestions for sharing the TechnoMe slide shows with others: 

• Determine an Audience: Prior to beginning the unit inform students who will be seeing 

their slide shows. Decide if students will share their presentation with the entire class or a 

small group of students. Consider expanding the audience to include family members. 

You can email a slide show to parents or print the slide show to create an All About Me 

booklet. 

• Create a Class Album for an Open House: Build a sense of community. Combine 

completed slide shows into a class album using instructions in Session 6. The album can 

be set to play automatically in the classroom during Open House or printed and placed 

outside the classroom door to introduce parents to the class. 

• Make a Class Bulletin Board: Personalize your classroom. Print Slide 4 in the template, 

which is the flower decorated with a student photo and images of things they like. Use 

the printouts to create a We Grow and Learn in Class X bulletin board. 

 

Ideas for extending the activities in the TechnoMe course: 

• Engage in Goal Setting: Have students set a personal or school-related goal using the 

template in Session 1 Skill Review. Brainstorm options for meeting the goal and then 

establish a plan. Monitor progress towards achieving the goal. Celebrate successful 

completion of the goal. 

• Build a My Family Graph: Recognize similarities and differences in families. List the 

members in the immediate family using the template in Session 3 Skill Review. Print the 

slide. Assemble the printouts into a simple graph to compare the number of people in 

each family. Use questioning to develop mathematical reasoning. For example, How 

many people have four members in their family? What is the biggest family size? What is 

the smallest family size?  
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• Collaborate to Complete a Puzzle: Recognize the unique physical characteristics of 

others. Transform a student photo into a puzzle using the resources in Session 3 Extension 

Activity. Trade with a friend that has the same number of puzzle pieces. Draw attention 

to the fact that although the puzzle design is the same, each puzzle is unique. Mix the 

two puzzle pieces together for an extra challenge.  

• Use a Graphic Organizer to Compare Similarities and Differences: Identify similarities and 

differences in others. Form a partner group. Have each person talk about themselves 

while the other practices actively listening. Afterwards, each person completes the Venn 

diagram in Session 5 Extension Activity. If working with older students, share the same 

diagram to have students jointly complete the organizer.  

 



 

 

 

Session 1 I am Special 

 

Session 1 
I am Special 

 

In this session, students will begin creating their "All About Me" slide show. The 

first task is to design a title slide using a Microsoft PowerPoint template. They will 

enter their name in a text box and customize the font by adjusting the size, 

style, and color. Next, students will complete a slide template that includes 

descriptive sentences, providing details such as their name, age, city, and 

favorite activity. As an optional step, students can fill out the "Fun Facts" 

template, sharing additional information like their favorite subject, what 

annoys them, and the things they enjoy reading or watching. 

 

Assignment 1: Create a Title Slide 

Assignment 2: What Makes You Special? 

 

Session 1 Review: Font Tools 

Session 1 Skill Review: Share Fun Facts 

Session 1 Extension Activity: About Data Files 
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Learn how to format 

text to make the title 

slide look great! 

Assignment 1 Create a Title Slide 

You are going to make an All About Me slide show. You can show it to your teacher, friends, 

parents, or other students so that they can learn about what makes you special. 

 

 
 

Open PowerPoint and the All About Me Template 

 Ask your teacher how to open the All About Me template. 

 
 

 

 

Add Student Name to the Title Slide 

 Place the cursor inside Student.  

 

 Double click to select the word.  

 

 Type your Name. 

 
  

Use the SHIFT key to 

make a CAPITAL letter. 
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Format the Font 

 Select your name. 

 Click the Font arrow.  

Pick a font from the list.  

 
 

 

Format the Font Size 

 Select your name. 

 Click the Font size arrow. 

Pick a font size.  

 
 

 

Format the Font Style 

 Select your name.  

 Click each font style to turn it ON. 

 To turn OFF a style, click on it again.  

 
 

 

 

  

Pick how you want 

the letters to look. 

The bigger the number, 

the larger the letters. 

Have fun with 

font styles! 
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Format the Text Color 

 Select your name.  

 Click the Font Color arrow. 

 Click on a color you like.  

 
 

Format the All About Me Title 

 Put the cursor in the words All About Me. 

Triple click to select all the words. 

 

 Make the words look great! 

o Format the font.  

o Set the size.  

o Apply a style.   

o Change the color.  

 

Save the File 

 Click Save on the Quick Access toolbar.  

 Click Save As. 

 Go to the place where you save your work. 

 Edit the name to All About Me Name. 

 

 Click Save. 

 

Close PowerPoint 

 Click the Close button.  

Pick your 

favorite color. 



 

 

This is a preview of the teacher guide. 
Pages have been omitted. 



 

 

 

Session 4 About My Family 

 

Session 4 
About My Family 

 

In this session, students create a slide about their family. They create a graph 

that shows the number of adults, children, and pets in their home. Using 

shapes, they use different images for each type of family member. An optional 

activity is available that has students construct their family tree using a cloud 

shape to add each person's name to a branch. 

 

Assignment 7: About Graphs 

Assignment 8: Build a Graph About Your Family 

 

Session 4 Review: About Shapes 

Session 4 Skill Review: Build a Family Tree 

Session 4 Extension Activity: Survey Your Friends 
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Assignment 7 About Graphs 

You are going to make a graph about your family. You will show how many adults, children, and 

pets are in your family by using shapes. Each type of information will have its own shape, so it's 

easy to understand the graph. 

 

Before you get started, learn about graphs. 

 

 

What is a Graph? 
 

A graph is a picture used to show information. A pictograph is a graph that uses shapes or small 

pictures, instead of numbers, to show how many things there are. A graph helps people 

understand things better.  

 

Information in a graph is called data.  

 

Data is things we can count or learn about. For example, if you count how many children are in 

your family, those numbers are data.  

 

Data helps us learn things and make decisions by counting or looking at what we know. 

 

 

Look at the Data 

 
 

Look at the graph and circle the correct answers. 

 

1. What shape is used to show the data for adults?  

  

 

   

 

 

2. What shape is used to show the data for children?  

  

 

   

 

 

3. What shape is used to show the data for pets?  
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Who Is In the Family? 
 

Look at the graph and circle the correct answers. 

 

 
 

4. How many adults are in the family? 
  

 1 2 3    

 

 

5. How many children are in the family? 
  

 1 2 3    

 

 

6. How many pets are there in the family? 
  

 1 2 3    

 

 

7. What has the most? Are there more adults or more children in the family? 
  

 adults children     

 

 

8. What has the least? Are there less children or less pets in the family? 
  

 children pets     

 

 

Solve the Problems 
 

Look at the graph and circle the correct answers. 

 

 
 

9. How many members are in the family? Count the shapes to find out! 
  

 2 4 6 8   

 

 

10. You need to give each pet a treat. How many treats do you need? 
  

 1 2 3    
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Assignment 8 Build a Graph About Your Family 

You are going to make a graph about your family! You will show how many adults, children, and 

pets are in your family by using shapes.  

 

How Many Members Are in Your Family? 
 

Complete the table with the number of adults, children, and pets in your family. 

 

  Number of Members in My Family 

 
adults  

 
children  

 
pets  

 

View the My Family Slide 

 Open All About Me Name in PowerPoint. 

 Pick My Family from the slides pane or press the PAGE DOWN key. 

 
 

Draw a Shape to Show One Adult 
 

 From the Insert tab, click Shapes. 

 Select a shape from the gallery. 

 

 

 Draw a shape to show one adult: 

 

 

TIP: Put the shape in the first box. 
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Apply a Shape Style 

 From the Shape Format tab, select a shape style from the gallery. 

 
 

Duplicate a Shape 

 IF you have two adults in the family, select the shape. 

 From the Home tab, click Copy. Pick Duplicate.  

OR press CTRL + D. 

 

 Place it in the next box: 

 

 

TIP: Line up the shapes. 

 

 

Add Shapes for Children and Pets to Complete the Graph 

 Use your skills to add the members of your family to the graph. 

 
 

• Use different shapes for adults, children, and pets. 

• 1 shape = 1 family member 

 

Total the Family Members 

 Type the number of family members in the text boxes: 

 

 
 

Save and Close PowerPoint 
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Session 4 Skill Review: Build a Family Tree 

 

 
 

1. Ask your teacher how to open the Family template. 

Save the file as Family YOUR NAME. Click Save. 
  

 

 

2. From the Insert tab, click Shapes.  Click the Cloud.  
  

 

 
3. Draw a cloud. 

4. Select it. Type Name of Person. 

 

 
  

5. Click the Shape Styles arrow.  Pick an option from the palette. 
  

  

6. Format the letters to make them look great! 

 

o Format the font.  

o Set the size.  

o Apply a style.   

o Change the color.  

  

   

Who is in your family? 

Use a cloud shape to 

add each family 

member to your tree. 

You can align the text! 
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7. Be creative! If you have family photos, add them to decorate your tree. 

    
  

8. Save and close PowerPoint. 

  

 Go to Session 5 Extension Activity to add this slide to your All About Me slide show. 

 

 



 

 

This is a preview of the teacher guide. 
Pages have been omitted. 
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Session 6 Review:  PowerPoint Quiz 

What Tool Should You Use? 
 

1. Pick the tool that changes the size of letters.  

 

  
 

   

  
 

   

  
 

 

 

 

2. Pick the tool that will add a picture onto a slide:  

 

  
 

  

     

  
 

  

     

  
 

  

 

 

 

3. Pick the tool that can draw a rectangle on a slide.  
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What Will This Do? 
 

4. What will this do? 

 

 
 

  draw a heart 

   

  crop a picture into a heart 

   

  make a picture small 

 

 

 

5. What will happen if you click the arrow? 

  

 

 
 

  show all the transitions 

   

  play the slide show 

   

  draw a text box 

 

 



 

 

 

 

Appendices 

 

Appendices 

 

Refer to the appendices for additional resources: 

 

Appendix A: Assessment Tools 

TechnoMe Skill Summary 

TechnoMe Marking Sheet 

Appendix B: Contact Information 
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TechnoMe Marking Sheet 

  

3 

Excellent 

Work! 

2 

Doing 

Great! 

1 

Keep 

Trying! 

 

Completion: 

All slides are complete. 

Transitions are between each slide.    

 

Quality of Slide Show: 

Includes information such as age, 

skills, goals, and likes. 

The words on each slide look great. 

The pictures tell about the student. 

   

 

Presentation Skills: 

Slide show is shared with others. 

Questions are asked to learn about 

similarities and differences. 

Speaks clearly. Listens to others. 

   

 

Self-Awareness: 

Able to identify things that make 

you unique.    

 

 

 

  



 

 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

This course includes a sample of a completed project. 
Teachers can use this resource for demonstration purposes 

or as a source of inspiration. 
 
 
 
 
 

 



All About Me
By Me... Jake



Jake

Hamilton



Fire Fighter
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